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Tutorial Outline 
Time (Tentative!) Module Topics Presenter 

8:00-8:30 1.  Eclipse Installation 
2.  Introduction/Overview 

  Installation of Eclipse and PTP 
  Eclipse architecture & organization overview 

Beth, Jeff 

 8:30-10:00 3. Eclipse basics (1.5 hr))   Eclipse basics; Creating a new project from CVS; 
Local, remote, and synchronized projects 

  Creating a synchronized project from CVS 
  Creating a sync project directly from source code 
  Editor features; MPI Features 

Beth 

Beth 
Jeff 
Beth 

10:00-10:15 BREAK 

10:30-12:00 4. Build/run (1.5 hr)   Building w/Makefile 
  Target configurations and launching a parallel app 
  Including Modules (Build Environment Mgmt) 

Jay  

12:00 – 1:00 Lunch 

1:00-3:00 4. Debugging (1 hr) 

5. Fortran (30 min) 
6. Adv/Misc (30 min) 

  Debugging an MPI program 
  Fortran 
  Adv features -  including XSEDE feature 

Beth 
Jeff 
Jeff 

3:00-3:15 BREAK 

3:15-4:45 
5. Performance Tuning & 
Analysis Tools 

  TAU, External Tools FrameWork  (:40) 
  Gprof/Gcov (:40)  
  GEM (:10) 

Wyatt  
Galen  
Alan  

4:45-5:00 6. Other Tools, Wrapup   PTP Future plans,  Other Tools, website, mailing 
lists, getting involved, Tutorial feedback 

Beth 



Final Slides, Installation 
Instructions 

 Please go to 
http://wiki.eclipse.org/PTP/
tutorials/XSEDE12 for slides and 
installation instructions 



Installation 

 Objective 
 To learn how to install Eclipse and PTP 

 Contents 
 System Prerequisites 
 Eclipse Download and Installation of “Eclipse for 

Parallel Application Developers” 
 Installation Confirmation 
 Updating the PTP within your Eclipse to the latest 

release 

Installation Install-0 



System Prerequisites 

 Local system (running Eclipse) 
 Linux (just about any version) 
 MacOSX (10.5 Leopard or higher) 
 Windows (XP on) 

 Java: Eclipse requires Sun or IBM Java 
 Only need Java runtime environment (JRE) 
 Java 1.6 or higher  

 Java 1.6 is the same as JRE 6.0 
 The GNU Java Compiler (GCJ), which comes 

standard on Linux, will not work! 
 OpenJDK, distributed with some Linux distributions, 

has not been tested by us but should work. 
 See http://wiki.eclipse.org/PTP/installjava 

Install-1 Installation 



Eclipse Packages 

 The current version of Eclipse (4.2) is also 
known as “Juno” 

 Eclipse is available in a number of different 
packages for different kinds of development 
 http://eclipse.org/downloads 

 For PTP, we recommend the all-in-one 
download: 
 Eclipse for Parallel Application Developers 

Install-2 Installation 



Exercise 

 Download the “Eclipse for Parallel Application 
Developers” package to your laptop 
 Your tutorial instructions will provide the location of 

the package 
 Make sure you match the architecture with that of 

your laptop 

 If your machine is Linux or Mac OS X, untar 
the file 
 On Mac OS X you can just double-click in the Finder 

 If your machine is Windows, unzip the file 
 This creates an eclipse folder containing the 

executable as well as other support files and 
folders 

Install-3 Installation 



Starting Eclipse 
  Linux 

  From a terminal window, enter 
“<eclipse_installation_path>/eclipse/eclipse &” 

  Mac OS X 
  From finder, open the eclipse folder where you installed 
 Double-click on the Eclipse application 
 Or from a terminal window 

  Windows 
 Open the eclipse folder 
 Double-click on the eclipse executable 

Install-4 Installation 



 Eclipse prompts for a workspace location at 
startup time 

 The workspace contains all user-defined data 
 Projects and resources such as folders and files 
 The default workspace location is fine for this tutorial 

Specifying A Workspace 

The prompt can be 
turned off 

Install-5 Installation 



Eclipse Welcome Page 

 Displayed when Eclipse is run for the first time 

Select “Go to the workbench” 

Install-6 
Installation 



Checking for PTP Updates 

 From time-to-time there may be newer PTP 
releases than the Indigo release 
 Juno and “Parallel package” updates are released only 

in Sept and February 

 PTP maintains its own update site with the 
most recent release 
 Bug fix releases can be more frequent than Indigo’s 

and what is within the parallel package 

 You must enable (and install from) the PTP-
specific update site before the updates will be 
found 

Install-7 Installation 



Updating PTP 

  Now select Help>Install New Software… 
  In the Work With: dropdown box, select the PTP update 

site you confirmed already: 

Install-8 Installation 



Updating PTP (2) 

  Easiest option is to check everything - which updates 
existing features and adds a few more 

  Select Next  to continue updating PTP 
  Select Next  to confirm features to install 

Install-9 Installation 



Updating PTP (3) 

  Accept the License agreement and select Finish  

  Select Yes when prompted to restart Eclipse 

Install-10 Installation 



Updating Individual Features 

  It’s also possible to update features without adding any 
new features 
  Open each feature and check the ones you want to update 

  Icons indicate: Grey plug: already installed 
                      Double arrow: can be updated 

                           Color plug: Not installed yet 

  Note: if network is slow, consider unchecking 

Install-11 Installation 



Restart after Install 

  If any new top-level features 
are installed, they will be 
shown on the welcome screen 

  We only updated PTP, so we 
land back at C/C++ 
Perspective  

Install-12 Installation 

  Help>About or Eclipse > About Eclipse …  
will indicate the release of PTP installed 

  Further Help>Check for Updates will find future updates on 
the PTP Update site 



Exercise 

1.  Launch Eclipse and select the default 
workspace 

2.  Configure Eclipse to check for PTP updates 
3.  Update all PTP features to the latest level 
4.  Restart Eclipse once the installation is 

completed 

Install-13 Installation 



Intro-0 Introduction 

Introduction 

 Objective 
 To introduce the Eclipse platform and PTP 

 Contents 
 New and Improved Features 
 What is Eclipse?  
 What is PTP? 



Intro-1 

What is Eclipse? 

 A vendor-neutral open-source workbench for 
multi-language development 

 A extensible platform for tool integration 
 Plug-in based framework to create, integrate 

and utilize software tools 

Introduction 



Intro-2 

Eclipse Features 

 Full development lifecycle support 
 Revision control integration (CVS, SVN, Git) 
 Project dependency management 
 Incremental building 
 Content assistance 
 Context sensitive help 
 Language sensitive searching 
 Multi-language support 
 Debugging 

Introduction 



Intro-3 

Parallel Tools Platform (PTP) 

  The Parallel Tools Platform aims to provide a highly 
integrated environment specifically designed for parallel 
application development 

  Features include: 
  An integrated development environment (IDE) that 

supports a wide range of parallel architectures and runtime 
systems 

  A scalable parallel debugger 
  Parallel programming tools  

(MPI, OpenMP, UPC, etc.) 
  Support for the integration  

of parallel tools 
  An environment that simplifies the  

end-user interaction with parallel systems 
  http://www.eclipse.org/ptp 

Introduction 



Eclipse PTP Family of Tools 
Coding & Analysis 

(C, C++, Fortran) 

Parallel Debugging 

Launching & 
Monitoring 

Performance Tuning 
(TAU, PPW, …) Intro-4 Introduction 



How Eclipse is Used 
Editing/Compiling 

Intro-5 

Remote 
Source Code 

Introduction 

Local Source 
Code 



How Eclipse is Used 
Launching/Monitoring 

Source Code 
Executable 

Introduction Intro-6 



How Eclipse is Used 
Debugging 

Source Code 
Executable 

Introduction Intro-7 



How Eclipse is Used 
Performance Tuning 

Source Code 
Executable 
Perf. Data 

Introduction Intro-8 



Eclipse Basics 
 Objective 

 Learn about basic Eclipse workbench concepts: 
projects,  

 Learn about projects: local, synchronized, remote 

 Contents 
 Workbench components: Perspectives, Views, Editors 
 Local, remote, and synchronized projects 
 Learn how to create and manage a C project 
 Learn about Eclipse editing features 

Eclipse Basics Basic-0 



Eclipse Basics 
  A workbench contains the menus, toolbars, editors and 

views that make up the main Eclipse window 

perspective Eclipse Basics 

view 
view 

view 

editor 

  The workbench represents 
the desktop development 
environment 
  Contains a set of tools  

for resource mgmt 
  Provides a common way 

of navigating through  
the resources 

  Multiple workbenches  
can be opened at the 
same time 

  Only one workbench can 
be open on a workspace 
at a time 

Basic-1 



Perspectives 

 Perspectives define the layout of views and 
editors in the workbench 

 They are task oriented, i.e. they contain 
specific views for doing certain tasks: 
 C/C++ Perspective for manipulating compiled code  
 Debug Perspective for debugging applications 
 System Monitoring Perspective for monitoring 

jobs 

  You can easily switch between perspectives 
 If you are on the Welcome screen now, select 

“Go to Workbench” now  

Eclipse Basics Basic-2 



Switching Perspectives 

  Three ways of changing  
perspectives 

1.  Choose the Window>Open  
Perspective menu option 
Then choose Other… 

2.  Click on the Open Perspective button in the 
upper right corner of  
screen (hover over it to 
see names) 

3.  Click on a  
perspective  
shortcut button 

Eclipse Basics Basic-3 



Which Perspective? 

Eclipse Basics Basic-4 

 The current perspective is displayed in the title 
bar 



Views 

 The workbench window is  
divided up into Views 

 The main purpose of a view is: 
 To provide alternative ways of presenting information 
 For navigation 
 For editing and modifying information  

 Views can have their own menus and toolbars 
 Items available in menus and toolbars are  

available only in that view 
 Menu actions only  

apply to the view 

 Views can be resized 

view 

view view 

Eclipse Basics Basic-5 



Stacked Views 

 Stacked views appear as tabs 
 Selecting a tab brings that view to the 

foreground 

Eclipse Basics Basic-6 



Expand a View 

 Double-click on a view/editor’s tab to fill the 
workbench with its content;  

 Repeat to return to original size 

 Window > Reset Perspective 
returns everything to original positions 

Basic-7 Eclipse Basics 

Double 
click 

Double 
click 



Help 

  To access help 
  Help>Help Contents 
  Help>Search 
  Help>Dynamic Help 

  Help Contents provides 
detailed help on different 
Eclipse features in a 
browser 

  Search allows you to 
search for help locally, or 
using Google or the Eclipse 
web site 

  Dynamic Help shows help 
related to the current 
context (perspective, view, 
etc.) 

Eclipse Basics Basic-8 



Eclipse Preferences 

  Eclipse Preferences allow 
customization of almost 
everything 

  To open use 
  Mac: Eclipse>Preferences… 
  Others: 

Window>Preferences… 

  The C/C++ preferences 
allow many options to be 
altered 

  In this example you can 
adjust what happens in 
the editor as you type. 

Eclipse Basics Basic-9 



Preferences Example 

More C/C++ preferences: 
 In this example the 

Code Style preferences 
are shown 

 These allow code to be 
automatically  
formatted in different 
ways 

Eclipse Basics Basic-10 



Exercise 
1.  Change to a different perspective 
2.  Experiment with moving and resizing views 

  Move a view from a stack to beside another view 
  Expand a view to maximize it; return to original size 

3.  Save the perspective 
4.  Reset the perspective 
5.  Open Eclipse preferences 
6.  Search for “Launching” 
7.  Make sure the “Build (if required) before 

launching” setting is disabled 

Eclipse Basics Basic-11 



Optional Exercise 
Best performed after learning about projects, CVS, and editors 

1.  Use source code formatting to format a source file, or a region 
of a source file 
  Use Source>Format menu 

2.  In Eclipse Preferences, change the C/C++ source code style 
formatter, e.g.  
  Change the indentation from 4 to 6 
  Make line wrapping not take effect until a line has a 

maximum line width of 120, instead of the default 80 
  Save a (new) profile with these settings 
  Format a source file with these settings 

3.  Revert the file back to the original – experiment with 
  Replace with HEAD, replace with previous from local history, 

or reformat using original style 

Eclipse Basics Basic-12 



Eclipse CVS 
 Objective 

 Learn how to use a source code repository with Eclipse 

 Contents 
 Checking out project in CVS 
 Converting to a Synchronized Project 
 Handling changes 

CVS Source Code Repository CVS-0 



Project Creation 
Alternative #2 

Checking out the project 

Using a Source Code Repository 
Introduction to Team Features 

In this scenario, we will check out code from a CVS source code repository, 
creating a local project, and then convert it to a synchronized project on a 

remote host. 
CVS-1 CVS Source Code 

Repository 



  Switch to CVS Repository 
Exploring perspective 
  Window > Open Perspective > Other… 
  Select CVS Repository Exploring 
  Select OK 

  Right click in CVS Repositories 
view and select New>Repository 
Location… 

Importing a Project from CVS 

CVS Source Code 
Repository 

CVS-2 



  Enter Host: cvs.ncsa.uiuc.edu 
  Repository path: 

/CVS/ptp-samples 

  For anonymous access: 
  User: anonymous 
  No password is required 
  Connection type: pserver (default) 

  For authorized access: 
  User: your userid 
  Password: your password 
  Connection type: change to extssh 

  Select Finish 

Add CVS Repository 

CVS Source Code 
Repository 

CVS-3 



  Expand the repository location 
  Expand HEAD 
  Expand samples 
  Right click on shallow and select 

Check Out As… 
  On Check Out As dialog, select 

Finish 

Checking out the Project 

CVS Source Code 
Repository 

CVS-4 

The default of 
�Check out as a 
project configured 
using the New 
Project Wizard� is 
what we want 



As project is checked out from CVS, the New Project 
Wizard helps you configure the Eclipse information to 
be added to the project 
 Expand C/C++ 
 Select C Project and click on Next> 
 Enter �shallow� as Project Name 

New Project Wizard 

CVS Source Code 
Repository 

CVS-5 

  Under  Project type, 
expand Makefile project 
  - scroll to the bottom 

  Select Empty Project 
  Select Remote Linux 

GCC Toolchain 
  You may need to uncheck 

�Show project types and 
toolchains only if they are 
supported on the platform�  

  In general, choose a remote 
toolchain that matches the 
compiler you intend to use on 
the remote system 

  Click on Finish 



  Switch to the C/C++ Perspective  
when prompted after checking 
our the code 

  You should now see the �shallow� project in your 
workspace 

Project successfully checked out 

CVS Source Code 
Repository 

CVS-6 

Expand the 
project root 
to see the 
project�s 
contents 



Convert to a 
Synchronized Project 

CVS-7 CVS Source Code 
Repository 



Synchronizing the Project 

 Because we will be running on a remote 
system, we must also build on that system 

 Source files must be available to build 
 We will use a synchronized project to do this 

 Only needs to be done once for each project 

 Files are synchronized automatically when 
they are saved 

 A full synchronize is also performed prior to a 
build 

CVS-8 CVS Source Code 
Repository 



Converting To Synchronized 

  Select File>New>Other… 
  Open the Remote folder 
  Select Convert C/C++ or 

Fortran Project to a 
Synchronized Project 

  Click Next> 

CVS-9 CVS Source Code 
Repository 



Convert Projects Wizard 

  Select checkbox next to �shallow� 
  For Connection:, click on New… 
  The tutorial instructor will indicate 

what to enter for: 
  Target name 
  Host name of remote system 
  User ID 
  Password 

  Click Finish to close it 
  See the connection name in  

the Convert Projects 
wizard  for Connection 

CVS-10 CVS Source Code 
Repository 



Convert Projects Wizard (2) 

Back in the Convert Projects dialog, 
we specify where the remote files 
will be stored 

  Enter a directory name in the 
Remote Directory field:  
select Browse… 
  Sample: /u/ac/trainXX/shallow  
  Project files will be copied under this 

directory 

  Click Finish 

  The project should synchronize 
automatically 

CVS-11 CVS Source Code 
Repository 



Synchronized Project 

  Back in the Project 
Explorer, decorator on 
project icon indicates 
synchronized project 

  Double-+  icon 

  Before sync 

  After sync 

CVS-12 CVS Source Code 
Repository 



Team Features 

CVS-13 CVS Source Code 
Repository 



�Team� Features 

 Eclipse supports integration with multiple 
version control systems (VCS) 
 CVS, SVN, Git, and others 
 Collectively known as �Team� services 

 Many features are common across VCS 
 Compare/merge 
 History 
 Check-in/check-out 

 Some differences 
 Version numbers 
 Branching 

CVS-14 CVS Source Code 
Repository 



CVS Features 

 Shows version numbers next to 
each resource 

 Marks resources that have 
changed 
 Can also change color (preference 

option) 

 Context menu for Team 
operations 

 Compare to latest, another 
branch, or history 

 Synchronize whole project (or any 
selected resources) 

CVS-15 CVS Source Code 
Repository 



How to tell that you�ve 
changed something 

 Open �calc.c� 
 Add comment at line 40 
 Save file 
 File will be marked �>� 

to indicate that it has 
been modified 

CVS-16 CVS Source Code 
Repository 



Comparing your version 
with what�s in the repository 

  Right-click on �calc.c� and 
select Compare 
With>Latest from HEAD 

  Compare editor will open 
showing differences 
between local (changed) 
file and the original 

  Buttons allow changes to 
be merged from right to 
left 

  Can also navigate between 
changes using buttons 

CVS-17 CVS Source Code 
Repository 



Revert To The Latest Version  

To replace your project contents to the current 
contents of the project in the src code repo, 

 Right-click on the �shallow� project and select 
Replace With>Latest from HEAD 

 Review the resources that will be replaced, 
then click OK 

CVS-18 CVS Source Code 
Repository 



Exercise 
 Check out the shallow project from CVS and 

convert it to a synchronized project as described 
in this module 

CVS Source Code Repository CVS-19 

Optional Exercise 
1.  Name every person who modified the Makefile 
2.  Identify which parts of the Makefile changed 

since revision 1.3 

Hint: Right-click the Makefile and select Team > Show History.  
Both of these can be done from the History view. 



Creating a Synchronized Project 
 Objective 

 Learn how to create and use synchronized projects 
 Learn how to create a sync project directly from source 

that already exists on a remote machine 

 Contents 
 Eclipse project types 
 Creating a synchronized project 
 Using synchronize filters 
 Converting an existing project to synchronized 

Synchronized Projects Sync-0 



Project Types 
 Local 

 Source is located on local machine, builds happen 
locally 

 Remote 
 Source is located on remote machine(s), build and 

launch takes place on remote machine(s) 

 Synchronized 
 Source is local, then synchronized with remote 

machine(s) (or vice-versa) 
 Building and launching happens remotely 

(can also happen locally) 

Synchronized Projects Sync-1 



Sync-2 

Remote Projects 
  Projects types can be: 

-2 

File%Service% Index%Service%

Launch%Service%

Build%Service%

Debug%Service%

Source%code%

Local% Remote%

Run%

Debug
%

Compute%

Edit%

Executable%

Synchronized Projects 
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Synchronized Projects 
  Projects types can be: 

-3 

File%Service% Index%Service%

Launch%Service%

Build%Service%

Debug%Service%

Local%source%
code%

Source%code%
copy%

Local% Remote%

Run%

Debug
%

Compute%

Edit% Search/Index%
NavigaAon%

Synchronize%

Executable%

Synchronized Projects 
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C, C++, and Fortran Projects 
Build types 

 Makefile-based 
 Project contains its own makefile (or makefiles) for 

building the application – or other build command 

 Managed 
 Eclipse manages the build process, no makefile 

required 

-4 Synchronized Projects 



Source Code for project 

 Source code exists on remote target  

Sync-5 Synchronized Projects 



Create Synchronized Project 

  In the Project Explorer, right click then choose 
  New>Synchronized C/C++ Project if your project is C/C++ only 

  New>Synchronized Fortran Project if your project contains Fortran 
files 

  This adds a Fortran nature so you can access Fortran properties, etc. 

Sync-6 Synchronized Projects 



Synchronized Projects Sync-7 

  Enter the Project Name 
  E.g. “shallow” 

  The Local Directory specifies 
where the local files are located 
  Leave as default 

  The Remote Directory specifies 
where the remote files are located 
  Select a connection to the remote 

machine, or click on New… to create 
a new one 
  (See next slide) 

  Browse for the directory on the 
remote machine 

New Synchronized Project Wizard 



Creating a Connection 

 In the Target Environment Configuration 
dialog 
 Enter a Target name  

for the remote host 
 Enter host name,  

user name, and  
user password or  
other credentials 

 Select Finish 

Sync-8 Synchronized Projects 



Sync-9 

  Choose the Project Type 
  If you are synchronizing with an  

existing project, use Makefile 
Project>Empty Project 

  Otherwise, choose the type of project 
you want to create 

  Choose the toolchain for the remote 
build 
  Use a toolchain that most closely 

matches the remote system 

  Choose a toolchain for the local 
build 
  This is used for advanced editing/

searching   

  Use Modify File Filtering… if 
required (see later slide) 

  Click Finish to create the project 

Project Type & Toolchain 

Synchronized Projects 



Synchronized Project 
  Synchronized projects are indicated 

with a “synchronized” icon 
  Right click on project to access 

Synchronization menu 
  Select Auto-Sync to enable/disable 

automatic syncing 
  Project Auto-Sync Settings are used 

to determine which configurations are 
synchronized (Active only, All or None) 

  Sync Active/All Now to manually 
synchronize 

  Filter… to manage synchronization 
filters 

Sync-10 Synchronized Projects 



Synchronize Filters 

 If not all files in the remote project should be 
synchronized, a filter can be set up 
 For example, it may not be desirable to synchronize 

binary files, or large data files 

 Filters can be created at the same time as the 
project is created 
 Click on the Modify File Filtering… button in the 

New Project wizard 

 Filters can be added later 
 Right click on the project and select 

Synchronization>Filter… 

Sync-11 Synchronized Projects 



Synchronize Filter Dialog 

  Files can be filtered individually 
by selecting/unselecting them in 
the File View 

  Include or exclude files based on 
paths 

  Include or exclude files based on 
regular expressions 

  Include or exclude files based on 
predefined patterns, such as 
“Binary files” 

Sync-12 Synchronized Projects 



Synchronized Project Properties 

  Synchronized project 
properties can be configured 
manually 

  Open the project properties, 
then select C/C++ 
Build>Synchronize 

  Each configuration is 
associated with a remote 
connection and a root 
directory 

  Can be changed manually, 
but only if you know what 
you are doing! 

Sync-13 Synchronized Projects 



Convert Project to Synchronized 

  If you have an existing project in your 
workspace, you can convert it to a 
synchronized project 

  Select File>New>Other… 
  Open the Remote folder 
  Select Convert C/C++ or Fortran 

Project to a Synchronized Project 
  Click Next> 
  Select the project to convert from the 

Candidates for conversion 
  Select a connection (or create a new 

one) 
  Browse for or enter a directory on the 

remote system 
  This should normally be an empty 

directory 

  Click Finish 
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Exercise 
 Create a synchronized project 

 Your login information and source directory will be 
provided by the tutorial instructor 

 Observe that the project files are copied to your 
workspace 

 Open a file in an editor and add a comment 
 Observe that the file is synchronized when you 

save the file 
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Optional Exercise 
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Editor Features 
 Objective 

 Learn about Eclipse editor features 

 Contents 
 Saving 
 Editor markers 
 Code analysis 
 Content assistance and templates 

Editor Features Editor-0 



Editors 
  An editor for a resource (e.g. a file) opens when you  

double-click on a resource 
  The type of editor depends on the type of the resource 

  .c files are opened with the  
C/C++ editor by default 

  You can use Open With to  
use another editor 

  In this case the default 
editor is fine (double-click) 

  Some editors do not just edit raw text 
  When an editor opens on a resource, it stays open across 

different perspectives 
  An active editor contains menus and toolbars specific to that 

editor 
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Saving File in Editor 

 When you change a file in the editor,  
an asterisk on the editor’s title bar 
indicates unsaved changes 

 Save the changes by using  
Command/Ctrl-S or File>Save 

 Undo last change using Command/Ctrl Z 
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Editor and Outline View 
  Double-click on 

source file  
  Editor will open in 

main view 

  Outline view is 
shown for file in 
editor 

  Console shows 
results of build, 
local runs, etc. 
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Include Paths 
  In order for editor and 

build features to work 
properly, Eclipse needs to 
know where your include 
files are located 

  The build environment on 
the remote host knows 
your include files etc., 
but we must tell Eclipse 
so that indexing, search, 
completion, etc. will 
know where things  
are 

  Open Project Properties 
  Expand C/C++ General 
  Select Paths and Symbols 
  Select Add… 
   A UNC-style path specifies  

//<connection>/<path> 
  Example 

//forge/usr/mpi/gcc/
openmpi-1.4.2/include 

  Select OK, OK 
  Will ask to rebuild.. 
  Select Yes 
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Source Code Editors & Markers 

  A source code editor is a 
special type of editor for 
manipulating source 
code 

  Language features are 
highlighted 

  Marker bars for showing 
  Breakpoints 
  Errors/warnings 
  Task Tags, Bookmarks 

  Location bar for 
navigating to interesting 
features in the entire file 

Icons: 
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Code Analysis (Codan) 
 If you see bug icons in the editor marker bar, they 

are likely suggestions from Codan 
 If you set up include paths properly, you may not see any 

 Code checkers can flag possible errors, even if 
code is technically correct 

 To turn them off, use Preferences 
Window > Preferences or Mac: Eclipse > Preferences 
  C/C++ > Code Analysis  
and uncheck  
all problems 

  Select OK to 
close  
Preferences  If icons don’t 

disappear: Right 
mouse on Project > 
Run C/C++ 
Code Analysis 
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Line Numbers 

  Text editors can show line numbers in the 
left column 

  To turn on line 
numbering: 
  Right-mouse click in 

the editor marker bar 
  Click on Show Line 

Numbers 
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  On demand hyperlink 
  In main.c line 135: 
  Hold down Command/Ctrl key 

e.g. on call to initialise 
  Click on initialise to navigate 

to its definition in the header file 
(Exact key combination  
depends on your OS) 

  E.g. Command/Ctrl and click on 
initialise 

  Open declaration 
  Right-click and select Open 

Declaration will also open the 
file in which the element is 
declared 

  E.g. in main.c line 29 right-click 
on decs.h and select Open 
Declaration 

Navigating to Other Files 

Note: may need to left-click 
before right-click works Editor Features Editor-8 



Content Assist & Templates 
  Type an incomplete function name e.g. “get” into the editor, 

and hit ctrl-space  
  Select desired completion value with cursor or mouse 

Hit ctrl-space again 
for code templates    Code Templates: type 

‘for’ and Ctrl-space 

More info on code templates later 
Editor Features Editor-9 



Inactive code 

 Inactive code will appear grayed out in the 
CDT editor 
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Exercise 
1.  Open an editor by double clicking on a source file in the 

Project Explorer 
2.  Use the Outline View to navigate to a different line in 

the editor 
3.  Back in main.c, turn on line numbering 
4.  In main.c, ctrl-click on line 99, master_packet, should 

navigate to its definition in the file 
5.  In worker.c, line 132, hover over variable p to see info 
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Optional Exercise 
1.  Type “for”, then activate content assist 

  Select the for loop with temporary variable template, insert it, 
then modify the template variable 

  Surround the code you just inserted with “#if 0” and “#endif” and 
observe that it is marked as inactive 

  Save the file 
2.  What do these keys do in the editor? 

  Ctrl+L;  Ctrl+Shift+P  (do it near some brackets) 
  Ctrl+Shift+/;     
  Ctrl+Shift+Y  and Ctrl+Shift+X    (do it on a word or variable name 

e.g.) 
  Alt+Down; Alt+Up 

3.  To make sure you didn’t do any damage, 
  Select any source files you changed and do rightmouse > replace 

with .. Latest from HEAD 
  Observe that your changes are gone.   
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MPI Programming 
 Objective 

 Learn about MPI features for your source files 

 Contents 
 Using Editor features for MPI 
 MPI Help features 
 Finding MPI Artifacts 
 MPI New Project Wizards 
 MPI Barrier Analysis 
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MPI-Specific Features 

  PTP’s Parallel Language Development Tools (PLDT) has 
several features specifically for developing MPI code 
 Show MPI Artifacts 
 Code completion / Content Assist 
 Context Sensitive Help for MPI 
 Hover Help 
 MPI Templates in the editor 
 MPI Barrier Analysis 

 PLDT has similar features for OpenMP, UPC, 
OpenSHMEM, OpenACC 
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 In Project Explorer, select a project, folder, or a 
single source file 
  The analysis will be run on the selected resources 

MPI-2 

Show MPI Artifacts 

-2 

  Run the analysis by 
clicking on drop-
down menu next to 
the analysis button 

  Select  Show MPI 
Artifacts 

  Works on local and 
remote files  

MPI Programming 



-3 

MPI Artifact View 

  Markers indicate the 
location of artifacts in 
editor 

  The MPI Artifact View 
lists the type and location 
of each artifact 

  Navigate to source code 
line by double-clicking on 
the artifact 

  Run the analysis on 
another file (or entire 
project!) and its markers 
will be added to the view 

  Click on column headings 
to sort  

  Remove markers via 
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MPI Editor Features 
  Code completion will show all 

the possible MPI keyword 
completions 

  Enter the start of a keyword 
then press <ctrl-space> 

-4 

  Hover over MPI API 
  Displays the function 

prototype and a 
description 

MPI Programming 
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Context Sensitive Help 
  Click mouse, then press help 

key when the cursor is within a 
function name 
  Windows: F1 key 
  Linux: ctrl-F1 key 
  MacOS X: Help key or 

HelpDynamic Help 
  A help view appears (Related 

Topics) which shows 
additional information 
(You may need to click on MPI 
API in editor again, to 
populate) 

  Click on the function name to 
see more information 

  Move the help view within your 
Eclipse workbench, if you like, 
by dragging its title tab 

-5 

Some special 
info has been 
added for MPI 
APIs 
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MPI Templates 

 Example:  
    MPI send-receive 

 Enter:  
   mpisr <ctrl-space> 

 Expands to a send-receive 
pattern 

 Highlighted variable names 
can all be changed at once 

 Type mpi <ctrl-space> <ctrl-
space> to see all templates 

Add more templates using Eclipse preferences! 
C/C++>Editor>Templates 
Extend to other common patterns 

-6 

 Allows quick entry of common patterns in MPI programming 
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MPI Barrier Analysis 
  Verify barrier 

synchronization in C/MPI 
programs 

  For verified programs, lists 
barrier statements that 
synchronize together 
(match) 

  For synchronization errors, 
reports counter example 
that illustrates and 
explains the error  

MPI-7 

Local files only 
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MPI Barrier Analysis (2) 

MPI-8 

Run the Analysis: 
 In the Project 

Explorer, select the 
project (or directory, 
or file) to analyze 

 Select the MPI 
Barrier Analysis 
action in the pull-
down menu 

MPI Programming 



MPI Barrier Analysis (3) 

 No Barrier Errors are found (no pop-up 
indicating error) 

 Two barriers are found 
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MPI Barrier Analysis Views 

MPI Barriers view 

Simply lists the barriers 

Like MPI Artifacts view, 
double-click to navigate 
to source code line (all 
3 views) 

Barrier Matches view 
Groups barriers that 
match together in a 
barrier set – all 
processes must go 
through a barrier in the 
set to prevent a 
deadlock 

Barrier Errors view  

If there are errors, a 
counter-example 
shows paths with 
mismatched number 
of barriers  
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Barrier Errors 

 Let’s cause a barrier mismatch error 
 Open worker.c in the editor by double-clicking 

on it in Project Explorer 
 At about line 125, 

enter a barrier: 
 Type MPI_B 
 Hit Ctl-space 
 Select MPI_Barrier 
 Add communicator 

arg MPI_COMM_WORLD   and closing semicolon 
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Barrier Errors (2) 

 Save the file 
 Ctl-S (Mac Command-S) or File > Save 
 Tab should lose asterisk indicating file saved 

 Run barrier analysis on shallow project again 
 Select shallow 

project in Project 
Explorer first 
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Barrier Errors (3) 

 Barrier Error is found 
 Hit OK to dismiss dialog 

 Code diverges on line 87 
 One path has 2 barriers, other has 1 

MPI-13 

Double-click 
on a row in 
Barrier Errors 
view to find 
the line it 
references in 
the code 
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Fix Barrier Error 

 Fix the Barrier Error  
before continuing 

 Double-click on the 
barrier in worker.c 
to quickly navigate 
to it 

 Remove the line and save the file 
 Re-run the barrier analysis to check that it has 

been fixed 
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Remove Barrier Markers 

 Run Barrier Analysis again to remove the error 
 Remove the Barrier Markers via the “X” in one 

of the MPI Barrier views 
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MPI New Project Wizards 

 Quick way to make a simple MPI project 
 File > New > C Project 

 “MPI Hello World” 
is good for trying out 
Eclipse for MPI 

MPI-16 MPI Features for 
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MPI New Project Wizards (2) 

 Next> and fill in (optional) Basic Settings 

MPI-17 MPI Features for 
Eclipse 

 Next> and fill in MPI Project 
                           Settings 
 Include path set in MPI 
Preferences can be added to 
project 



MPI New Project Wizards (3) 

 Select Finish and “MPI Hello World” project 
is created 

MPI-18 MPI Features for 
Eclipse 



MPI Preferences 

 Settings for MPI New Project wizards 
 MPI Include paths, if set in MPI 

Preferences, are added in MPI New 
Project Wizard 
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Exercise 

1.  Find MPI artifacts in ‘shallow’ project 
  Locate all the MPI communication (send/receive) 

calls 

2.  Use content assist to add an api call 
  E.g., Type MPI_S, hit ctl-space 

3.  Use hover help 
4.  Use a template to add an MPI code template 

  On a new line, type mpisr and ctl-space… 
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Optional Exercise 

1.  Insert an MPI_Barrier function call into one of 
your source files using content assist 
  E.g. Line 125 of worker.c 

2.  Save the file 
3.  Run Barrier Analysis on the project 
4.  Locate the source of the barrier error and 

remove the statement 
5.  Re-run barrier analysis to observe that the 

problem has been fixed 
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Building a Project 

 Objective 
 Learn how to build an MPI program on a remote 

system 

 Contents 
 How to change build settings  
 How to start a build and view build output 
 How to clean and rebuild a project 
 How to create build targets 

Build-0 Building a Project 



Starting the Build 

  Select the project in Project Explorer 

  Click on the     hammer button in toolbar to run a build 
using the active build configuration 
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  Build output will be visible in console 

Viewing the Build Output 
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Build Problems 

  Build problems will be 
shown in a variety of 
ways 
  Marker on file 
  Marker on editor line 
  Line is highlighted 
  Marker on overview ruler 
  Listed in the Problems 

view  

  Double-click on line in 
Problems view to go 
to location of error in 
the editor 
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Forcing a Rebuild 

  If no changes have been made,  
make doesn�t think a build is needed 

  In Project Explorer, right click on 
project 
  Select Clean Project 
  Choose to clean all projects, or select specific 

projects to clean 

  Build console will display results 

  Rebuild project by clicking on build 
button again 
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  By default 
  The build button will run �make all� 
  Cleaning a project will run �make clean� 

  Sometimes, other build targets are 
required 

  Open Make Targets view 
  Select project and click on New 

Make Target button 
  Enter new target name 
  Modify build command if desired 
  New target will appear in view 
  Double click on target to activate 

Creating Make Targets 
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Build Configuration 

  The build configuration is specified in the project properties 
  Open the properties by right-clicking on the project name in the Project 

Explorer view and selecting Properties (bottom of the context menu 
list) 

Build-6 Building a Project 

  C/C++ Build 
  Configure the build command 
  Default is �make� but this can be 

changed to anything 

  C/C++ Build > Settings 
  Binary and Error parser selection 
  Tool Chain settings (managed projects 

only) 

  C/C++ Build > Environment 
  Modify/add environment variables passed 

to build 

  C/C++ Build > Logging 
  Enable/disable build logging 



Selecting Build Configuration 

  Multiple build configurations may be available 
  Remote and local build configuration 
  Build configurations for different architectures 

  The active build configuration is set from the Build 
Configurations project context menu 
  Right click on project, then select the build configuration from the 

Build Configurations > Set Active menu  
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Configuring Build Modules 

  If the remote system 
has Modules installed, a 
custom set of modules 
can be configured for 
building C/C++ projects 

  In the project 
properties, navigate to 
C/C++ Build > 
Environment 
Management 

  Check Use an 
environment 
management system 
to customize the 
remote build 
environment 
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Configuring Build Modules 

  Select modules 
from the list 

  Use the Filter 
list field to 
quickly find 
modules with a 
given name 

Build-9 Building a Project 

  Click Select Defaults to check only those modules that are 
present in a new Bash login shell 



Configuring Build Modules 

  To build the project, Eclipse will 
  Open a new Bash login shell 
  Execute module purge 
  Execute module load for each selected module 
  Run make 

  Module commands are displayed in the Console view during build 
  Beware of modules that must be loaded in a particular order, or 

that contain common paths like /bin or /usr/bin 
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Exercise 

1.  Start with your �shallow� project 
2.  Build the project 
3.  Edit a source file and introduce a compile error 

  In main.c, line 97, change �;� to �:� 
  Save, rebuild, and watch the Console view 
  Use the Problems view to locate the error 
  Locate the error in the source code by double 

clicking on the error in the Problems view 
  Fix the error 

4.  Rebuild the project and verify there are no build errors 

Building a Project 
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Optional Exercise 

1.  Open the Makefile in Eclipse.  Note the line starting with 
“tags:” – this defines a make target named tags. 

2.  Open the Outline view while the Makefile is open.  What icon 
is used to denote make targets in the Outline? 

3.  Right-click the tags entry in the Outline view.  Add a Make 
Target for tags. 

4.  Open the Make Targets view, and build the tags target. 

5.  Rename Makefile to Makefile.mk 
6.  Attempt to build the project; it will fail 
7.  In the project properties (under the C/C++ Build category), 

change the build command to:  make –f Makefile.mk 
8.  Build the project; it should succeed 
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Running an Application 
 Objective 

 Learn how to run an MPI program on a remote system 

 Contents 
 Creating a run configuration 
 Configuring the application run 
 Monitoring the system and jobs 
 Controlling jobs 
 Obtaining job output 

Running an Application Run-0 



Run-1 

  Open the run configuration  
dialog Run>Run 
Configurations… 

  Select Parallel Application 
  Select the New button 

Or, just double-click on  
Parallel Application 
to create a new one  

Creating a Run Configuration 

Note: We use �Launch Configuration� as a generic term to refer to either a 
�Run Configuration� or a �Debug Configuration�, which is used for debugging. 

Running an Application 
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Set Run Configuration Name 

  Enter a name for this run configuration 
  E.g. �shallow-torque� 

  This allows you to easily re-run the same application 
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Configuring the Target System 

  In Resources tab, select 
a Target System 
Configuration that 
corresponds to your target 
system 
  The tutorial instructor will 

indicate what Target System 
Configuration to select 

  Target system 
configurations can be 
generic or can be specific 
to a particular system 

  Use the specific 
configuration if available, 
or the generic 
configuration that most 
closely matches your 
system 
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Configure the Connection 

  Choose a connection to 
use to communicate with 
the target system 

  If no connection has been 
configured, click on the 
New button to create a 
new one 
  Fill in connection information, 

then click ok 

  The new connection 
should appear in the 
dropdown list 
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Resources Tab 

  The content of the 
Resources tab will vary 
depending on the target 
system configuration 
selected  

  This example shows the 
TORQUE configuration 

  For TORQUE, you will 
normally need to select 
the Queue and the 
Number of nodes 

  For parallel jobs, choose 
the MPI Command and 
the Number of Tasks 
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Viewing the Job Script 

  Some target 
configurations will 
provide a View Script  
button 

  Click on this to view the 
job script that will be 
submitted to the job 
scheduler 

  Batch scheduler 
configurations should 
also provide a means of 
importing a batch script 
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Application Tab 

  Select the Application 
tab 

  Choose the 
Application program 
by clicking the Browse 
button and locating the 
executable on the 
remote machine  
  Use the same 
�shallow� executable 

  Select Display output 
from all processes in 
a console view 
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Arguments Tab (Optional) 

  The Arguments tab lets 
you supply command-line 
arguments to the 
application  

  You can also change the 
default working directory 
when the application 
executes 

-8 Running an Application 



Run-9 

Environment Tab (Optional) 

  The Environment tab 
lets you set environment 
variables that are passed 
to the job submission 
command 

  This is independent of the 
Environment Management 
(module/softenv) support 
described in a separate 
module 
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Synchronize Tab (Optional) 

  The Synchronize tab lets 
you specify upload/
download rules that are 
execute prior to, and after 
the job execution 

  Click on the New 
upload/download rule 
buttons to define rules 

  The rule defines which file 
will be uploaded/
downloaded and where it 
will be put 

  Can be used in 
conjunction with program 
arguments to supply input 
data to the application 
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Common Tab (Optional) 

  The Common tab is 
available for most launch 
configuration types (not 
just Parallel Application) 

  Allows the launch 
configuration to be 
exported to an external 
file 

  Can add the launch 
configuration to the 
favorites menu, which is 
available on the main 
Eclipse toolbar 

  Select Run to launch 
the job 
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Run 

 Select Run to launch the job 
 You may be asked to switch to the System 

Monitoring Perspective 

 Select Remember my decision so you 
won�t be asked again 

 Select Yes to switch and launch the job 

Run-12 Building and Running 



System Monitoring Perspective 
  System view 

  Jobs running 
on system 

  Active jobs 

  Inactive jobs 

  Messages 

  Console  
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Moving views 

 The System Monitoring Perspective overlaps 
the Active Jobs and Inactive Jobs views 

 To split them apart and see both at once,  
drag the tab for the Inactive Jobs view to 
the lower half of its area, and let go of mouse 
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System Monitoring 

  System view, with 
abstraction of system 
configuration 

  Hold mouse button 
down on a job in 
Active Jobs view to 
see where it is 
running in System 
view 

  Hover over node in 
System view to see 
job running on node 
in Active Jobs view 
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One node with 
16 cores 
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  Job initially appears in 
Inactive Jobs view 

  Moves to the Active Jobs 
view when execution begings 

  Returns to Inactive Jobs 
view on completion 

  Status refreshes  
automatically every 60 sec 

  Can force refresh with menu 
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  Right click on a job to open 
context menu 

  Actions will be enabled IFF 
  The job belongs to you 
  The action is available on the 

target system 
  The job is in the correct state for 

the action 

  When job has COMPLETED, it 
will remain in the Inactive 
Jobs view 
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  After status changes to 
COMPLETED, the output is 
available 
  Right-click on the job  
  Select Get Job Output to display 

output sent to standard output 
  Select Get Job Error to retrieve 

output sent to standard error 

  Output/Error info shows in 
Console View 

  Jobs can be removed by 
selecting Remove Job Entry 
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Exercise 

 Start with your �shallow� project 
 Create a run configuration 
 Complete the Resources tab 
 Select the executable in the Application tab 
 Submit the job 
 Check the job is visible in the Inactive Jobs 

view, moves to the Active Jobs view when it 
starts running, then moves back to the 
Inactive Jobs view when completed 

 Remove the job from the Inactive Jobs view 

Running an Application 



Fortran 
 Objectives 

 Learn how to create and convert Fortran projects 
 Learn to use Fortran-specific editing features 
 Learn about Fortran-specific properties/preferences 

 Contents 
 Fortran projects 
 Using the Fortran editor 
 Fortran project properties and workbench preferences 

 Prerequisites 
 Basics (for exercises) 
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Configuring Fortran Projects 
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Project Properties 

  Right-click Project 
  Select Properties… 

 Project properties are settings 
that can be changed for each 
project 

  Contrast with 
workspace preferences, 
which are the same 
regardless of what 
project is being edited 
  e.g., editor colors 
  Set in Window 

Preferences 
(on Mac, Eclipse 
Preferences) 

  Careful! Dialog is 
very similar 
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Converting to a Fortran Project 

 Are there categories labeled Fortran General 
and Fortran Build in the project properties? 

No Fortran categories 

 If not, the project is not a Fortran Project 
 Switch to the Fortran Perspective 
 In the Fortran Projects view, right-click on the 

project, and click Convert to Fortran Project 
 Don�t worry; it�s still a C/C++ project, too 

 Every Fortran project is also a C/C++ Project 

Do this 
once 
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Project Location 

  How to tell where a project 
resides? 

  In the project properties 
dialog, select the 
Resource category 
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Error Parsers 

 Are compiler errors not appearing in the 
Problems view? 
 Make sure the correct error parser is enabled 
 In the project properties, navigate to 

C++ BuildSettings or Fortran BuildSettings 
 Switch to the Error Parsers tab 
 Check the error parser(s) for your compiler(s) 

Do this 
once 

Fortran Projects Fortran-5 



Fortran Source Form Settings 
 Fortran files are either free form or fixed form; 

some Fortran files are preprocessed (#define, #ifdef, etc.) 

  Source form determined by filename extension 
  Defaults are similar to most Fortran compilers: 

    Fixed form:  .f  .fix  .for  .fpp  .ftn  .f77 

    Free form:  .f08  .f03  .f95  .f90   < unpreprocessed 
 .F08  .F03  .F95  .F90   < preprocessed 

 Many features will not work if filename extensions 
are associated with the wrong source form 
(outline view, content assist, search, refactorings, etc.) 
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Fortran Source Form Settings 

  In the project 
properties, select 
Fortran General 
Source Form   

  Select source form 
for each filename 
extension 

  Click OK 

Do this 
once 
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Enabling Fortran Advanced Features 

 Some Fortran features are disabled by default  
 Must be explicitly enabled 

 In the project properties dialog, 
select Fortran General  Analysis/Refactoring 

 Click Enable 
Analysis/ 
Refactoring 

 Close and re-open 
any Fortran editors 

 This turns on the 
�Photran Indexer� 
 Turn it off if it�s slow 

Do this 
once 
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Exercise 

1.  Convert shallow to a Fortran project 

2.  Make sure errors from the GNU Fortran 
compiler will be recognized 

3.  Make sure *.f90 files are treated as 
�Free Form� which is unpreprocessed 

4.  Make sure search and refactoring will work in 
Fortran 
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Advanced Editing 

Code Templates 
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Code Templates 
(C/C++ and Fortran) 

 Auto-complete common code patterns 
 For loops/do loops, if constructs, etc. 
 Also MPI code templates 

 Included with content assist proposals 
(when Ctrl-Space is pressed) 
 E.g., after the last line in tstep.f90, type �sub� and  

press Ctrl-Space 
 Press Enter to insert the template 
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Code Templates (2) 
(C/C++ and Fortran) 

 After pressing enter to insert the code 
template, completion fields are highlighted 

 Press Tab to move between completion fields 
 Changing one instance of a field changes all 

occurrences 
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Exercise 

  Open tstep.f90 and retype the last loop nest 

  Use the code template to complete the do-loops 

  Use content assist to complete variable names 
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Custom Code Templates 
(Fortran) 

 Customize code templates in Window   
Preferences  Fortran  Templates 

 Can import/export templates to XML files 
Fortran Projects Fortran-14 



Search & Refactoring 
 Objectives 

 Develop proficiency using Eclipse’s textual and 
language-based search and navigation capabilities 

 Introduce common automated refactorings 

 Contents 
 Searching 
 Refactoring and Transformation 

 Prerequisites 
 Basics 
 Fortran 

Advanced Features Advanced-0 



Find/Replace within Editor 

 Simple Find within editor buffer 
 Ctrl-F (Mac: Command-F) 

3-1 Module 3 



Mark Occurrences 
(C/C++ Only) 

 Double-click on a variable in the CDT editor 
 All occurrences in the source file are 

highlighted to make locating the variable 
easier 

 Alt-shift-O to turn off (Mac: Alt-Cmd-O) 
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Language-Based Searching 
(C/C++ and Fortran) 

3-3 Module 3 

  �Knows� what things can 
be declared in each 
language (functions, 
variables, classes, 
modules, etc.) 

  E.g., search for every call 
to a function whose name 
starts with �get� 

  Search can be project- or 
workspace-wide 



Find References 
(C/C++ and Fortran) 

 Finds all of the places where a variable, 
function, etc., is used 
 Right-click on an identifier in the editor 
 Click ReferencesWorkspace 

or ReferencesProject 

 Search view 
shows matches 
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Open Declaration 
(C/C++ and Fortran) 

  Jumps to the declaration of 
a variable, function, etc., 
even if it�s in a different 
file 

  Left-click to select identifier 
  Right-click on identifier 
  Click Open Declaration 

  C/C++ only: 
Can also Ctrl-click  
(Mac: Cmd-click) on an 
identifier to �hyperlink� to 
its declaration 

3-5 Module 3 

Goes to its declaration 
in copy.c 



Search – Try It! 

1.  Find every call to MPI_Recv in Shallow. 

2.  In worker.c, on line 42, there is a declaration 
float p[n][m]. 

a)  What is m (local? global? function parameter?) 

b)  Where is m defined? 

c)  How many times is m used in the project? 

3.  Find every C function in Shallow whose name 
contains the word time 
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Refactoring and Transformation 
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Refactoring 

  Refactoring is the research 
motivation for Photran @ Illinois 
  Illinois is a leader in refactoring research 

  �Refactoring� was coined in our group 
(Opdyke & Johnson, 1990) 

  We had the first dissertation… 
(Opdyke, 1992) 

  …and built the first refactoring tool… 
(Roberts, Brant, & Johnson, 1997) 

  …and first supported the C preprocessor 
(Garrido, 2005) 

  Photran�s agenda: refactorings for HPC, 
language evolution, refactoring framework 

  Photran 7.0: 31 refactorings 

(making changes to source code that don�t affect the behavior of the program) 
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Refactoring Caveats 

 Photran can only refactor free form code that 
is not preprocessed 
 Determined by Source Form settings 

(recall from earlier that these are configured in  
Project Properties: Fortran GeneralSource Form) 

3-9 Module 3 

 Refactor menu will be empty if 
  Refactoring not enabled in project properties 

(recall from earlier that it is enabled in  
Project Properties: Fortran GeneralAnalysis/Refactoring) 

  The file in the active editor is fixed form 
  The file in the active editor is preprocessed 

✔ Free Form, Unpreprocessed: .f08 .f03 .f95 .f90 

✖ Free Form, Preprocessed: .F08 .F03 .F95 .F90 

✖ Fixed Form: .f .fix .for .fpp .ftn .f77 



Rename Refactoring 
(also available in Fortran) 

 Changes the name of a variable, function, etc., 
including every use 
(change is semantic, not textual, and can be workspace-wide) 

 Only proceeds if the new name will be legal 
(aware of scoping rules, namespaces, etc.) 

 Switch to C/C++ Perspective 
 Open a source file 
 In the editor, click on a 

variable or function name 
 Select menu item 

RefactorRename 
 Or use context menu 

 Enter new name 
3-10 Module 3 

In Java (Murphy-Hill et al., ICSE 2008): 



Rename in File 
(C/C++ Only) 

3-11 Module 3 

  Position the caret 
over an identifier. 

  Press Ctrl-1 
(Command-1 on Mac). 

  Enter a new name.  
Changes are 
propagated within 
the file as you type. 



  Moves statements into a new function, replacing the 
statements with a call to that function 

  Local variables are passed as arguments 

Extract Function Refactoring 

  Select a sequence of 
statements 

  Select menu item 
Refactor 
Extract Function… 

  Enter new name 

(also available in Fortran - �Extract Procedure�) 
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  Fortran does not require variable declarations 
(by default, names starting with I-N are integer variables; others are reals) 

  This adds an IMPLICIT NONE statement and adds explicit 
variable declarations for all implicitly declared variables 

Introduce IMPLICIT NONE Refactoring 

  Introduce in a single file by 
opening the file and selecting 
RefactorCoding Style 
Introduce IMPLICIT NONE… 

  Introduce in multiple files by 
selecting them in the Fortran 
Projects view, right-clicking on 
the selection, and choosing 
RefactorCoding 
StyleIntroduce IMPLICIT 
NONE… 
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  Interchange Loops   CAUTION: No check for behavior preservation 

  Swaps the loop headers in a two-loop nest 
  Select the loop nest, click menu item RefactorDo Loop  

Interchange Loops (Unchecked)…  

Loop Transformations 
(Fortran only) 

3-14 Module 3 

Old version traverses 
matrices in row-major order 

New version traverses 
in column-major order 
(better cache performance) 



Loop Transformations 
(Fortran only) 

3-15 Module 3 

  Unroll Loop 
  Select a loop, click RefactorDo LoopUnroll Loop…  

do i = 1, 10 
  print *, 10*i 
end do 

do i = 1, 10, 4 
  print *, 10*i 
  print *, 10*(i+1) 
  print *, 10*(i+2) 
  print *, 10*(i+3) 
end do 

Unroll 4× 



Refactoring & Transformation – Try It! 

In tstep.f90… 

1.  In init.c, extract the printf statements at 
the bottom of the file into a new function 
called print_banner 

2.  In worker.c, change the spellings of 
neighbour_send and neighbour_receive 
to American English 

3.  In tstep.f90, make the (Fortran) tstep 
subroutine IMPLICIT NONE 
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NCSA/XSEDE Features 
 Objectives 

 Install NCSA’s GSI auth and XSEDE support plug-ins 
 Become familiar with the System menu 

 Contents 
 Capabilities 
 Installation 

 Prerequisites 
 (none) 

Advanced Features: NCSA/XSEDE  NCSA-0 



Additional Plug-ins from NCSA 

 NCSA publishes additional plug-ins can be 
added onto an existing PTP installation 

 Contribute a System menu to the menu bar 
with XSEDE- and NCSA-specific commands 

NCSA-1 Advanced Features: NCSA/XSEDE  



System Menu 

  Open Web content in Eclipse: 

  Open XSEDE User Portal 

  Open User Guide for a machine 

  Open an SSH terminal 
(as an Eclipse view) 

NCSA-2 Advanced Features: NCSA/XSEDE  

Eclipse-integrated SSH terminals are provided 
by the Remote System Explorer (RSE), one of 
the features that is included in the Eclipse for 
Parallel Application Developers package. 



System Menu 

  Shortcuts for common PTP tasks: 

  Add Remote Environment adds a 
Remote Tools connection for a 
particular machine 

  Add System Monitor opens the 
System Monitoring perspective and 
begins monitoring a particular 
machine 
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System Menu 

  The plug-in is preconfigured with 
information about XSEDE and 
NCSA resources 

  The bottom four commands 
generally prompt for a system 

  Select System can be used to 
eliminate this prompt, so these 
commands always act on a 
particular system 
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MyProxy Logon 

  MyProxy Logon allows you 
to authenticate with a 
MyProxy server 
  Often myproxy.teragrid.org 

  It stores a “credential,” which 
is usually valid for 12 hours 

  During these 12 hours, SSH 
connections to XSEDE 
resources will not require a 
password; they can use the 
stored credential 
  However, you must enter the 

correct username for that 
machine! 
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Installation 

1.  Click Help > Install New Software 
2.  Click Add to open the Add Repository dialog 
3.  In the Location field, enter 

          http://forecaster.ncsa.uiuc.edu/updates/juno 

and then click OK to close the Add dialog 
4.  Select the following: 

 GSI Authentication and MyProxy Logon Support 
 NCSA and XSEDE System Support 

5.  Click Next and complete the installation 
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Parallel Debugging 

Parallel Debugging 

 Objective 
 Learn the basics of debugging parallel programs 

 Contents 
 Launching a debug session 
 The Parallel Debug Perspective 
 Controlling sets of processes 
 Controlling individual processes 
 Parallel Breakpoints 
 Terminating processes 

Debug-0 



Debugging Setup 

  Debugging requires interactive access to the application 
  Can use any of the -Interactive target configurations 

  Torque-Generic-Interactive 
  PBS-Generic-Interactive 
  OpenMPI-Generic-Interactive 

Parallel Debugging Debug-1 



Create a Debug Configuration 

  A debug configuration is 
essentially the same as a run 
configuration (like we used 
in the Running an Application 
module) 

  It is possible to re-use an 
existing configuration and 
add debug information 

  Use the drop-down next to 
the debug button (bug icon) 
instead of run button 

  Select Debug 
Configurations… to open 
the Debug Configurations 
dialog 

Parallel Debugging Debug-2 



Copy the Existing Configuration 

  Select the existing 
configuration 

  Click on the copy button 
to create a duplicate 
configuration 

Parallel Debugging Debug-3 



Configure the Resource Tab 

  Select the new 
resource manager 

  Choose the debug 
queue 

  Choose the mpirun 
command 

  Select the number of 
cores (in this case 
use 4) 

Parallel Debugging Debug-4 



Configure the Debug Tab 

  Select Debugger 
tab 

  Set the debugger 
path to the sdm in 
your home directory 

  Debugger session 
address should not 
need to be changed 

  Click on Debug to 
launch the program 

Parallel Debugging Debug-5 



Exercise 

 Open the debug configuration dialog 
 Copy an existing configuration 

 Or create a new configuration (if you don’t already 
have one) 

 Select an –Interactive target configuration 
 Configure the Debug tab 
 Launch the debugger 

Parallel Debugging Debug-6 



  Parallel Debug 
view shows job 
and processes 
being debugged 

  Debug view shows 
threads and call 
stack for individual 
processes 

  Source view 
shows a current 
line marker for all 
processes 

The Parallel Debug Perspective (1) 
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The Parallel Debug Perspective (2) 

  Breakpoints view 
shows breakpoints 
that have been set 
(more on this later) 

  Variables view 
shows the current 
values of variables 
for the currently 
selected process in 
the Debug view  

  Outline view (from 
CDT) of source 
code 
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Stepping All Processes 

  The buttons in the 
Parallel Debug View 
control groups of 
processes 

  Click on the Step Over 
button 

  Observe that all process 
icons change to green, 
then back to yellow 

  Notice that the current 
line marker has moved to 
the next source line 
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Stepping An Individual Process 
  The buttons in the 

Debug view are used 
to control an 
individual process, in 
this case process 0 

  Click the Step Over 
button 

  You will now see two 
current line markers, 
the first shows the 
position of process 0, 
the second shows the 
positions of processes 
1-3 
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Process Sets (1) 

  Traditional debuggers apply operations to a single 
process 

  Parallel debugging operations apply to a single process 
or to arbitrary collections of processes  

  A process set is a means of simultaneously referring to 
one or more processes 
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Process Sets (2) 

  When a parallel debug session is first started, all 
processes are placed in a set, called the Root set  

  Sets are always associated with a single job 
  A job can have any number of process sets 
  A set can contain from 1 to the number of processes in 

a job 
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Operations On Process Sets 

  Debug operations on the 
Parallel Debug view 
toolbar always apply to the 
current set: 
  Resume, suspend, stop, 

step into, step over, step 
return 

  The current process set is 
listed next to job name 
along with number of 
processes in the set 

  The processes in process 
set are visible in right hand 
part of the view 

Root set = all processes 
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Create set Remove  
from set 

Delete 
set 

Change 
current set 

Managing Process Sets 

  The remaining icons in the toolbar of the Parallel 
Debug view allow you to create, modify, and delete 
process sets, and to change the current process set 
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Creating A New Process Set 
  Select the processes 

you want in the set by 
clicking and dragging, 
in this case, the last 
three 

  Click on the Create 
Set button 

  Enter a name for the 
set, in this case 
workers, and click OK 

  You will see the view 
change to display only 
the selected processes 
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Stepping Using New Process Set 
  With the workers set 

active, click the Step 
Over button 

  You will see only the 
first current line 
marker move 

  Step a couple more 
times 

  You should see two line 
markers, one for the 
single master process, 
and one for the 3 
worker processes 
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Process Registration 

 Process set commands apply to groups of 
processes 

 For finer control and more detailed 
information, a process can be registered and 
isolated in the Debug view 

 Registered processes, including their stack 
traces and threads, appear in the Debug view 

 Any number of processes can be registered, 
and processes can be registered or  
un-registered at any time 
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Process Registration (2) 
  By default, process 0 was 

registered when the debug 
session was launched 

  Registered processes are 
surrounded by a box and 
shown in the Debug view 

  The Debug view only shows 
registered processes in the 
current set 

  Since the “workers” set 
doesn’t include process 0, it 
is no longer displayed in the 
Debug view 
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Registering A Process 

  To register a process, 
double-click its process 
icon in the Parallel 
Debug view or select a 
number of processes and 
click on the register 
button 

  To un-register a process, 
double-click on the 
process icon or select a 
number of processes and 
click on the unregister 
button 

Individual 
(registered) 
processes 

Groups (sets) 
of processes 
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Current Line Marker 

 The current line marker is used to show the 
current location of suspended processes 

 In traditional programs, there is a single 
current line marker (the exception to this is 
multi-threaded programs)  

 In parallel programs, there is a current line 
marker for every process 

 The PTP debugger shows one current line 
marker for every group of processes at the 
same location 
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Multiple processes marker  

Registered process marker 

Un-registered process marker 

Colors And Markers 

  The highlight color depends on 
the processes suspended at 
that line: 
  Blue: All registered process(es) 
  Orange: All unregistered 

process(es) 
  Green: Registered or unregistered 

process with no source line (e.g. 
suspended in a library routine) 

  The marker depends on the 
type of process stopped at that 
location 

  Hover over marker for more 
details about the processes 
suspend at that location 
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  Apply only to processes in the particular set that is 
active in the Parallel Debug view when the breakpoint 
is created 

  Breakpoints are colored depending on the active 
process set and the set the breakpoint applies to: 
 Green indicates the breakpoint set is the same  

as the active set. 
  Blue indicates some processes in the breakpoint set are 

also in the active set (i.e. the process sets overlap)  
  Yellow indicates the breakpoint set is different from the 

active set (i.e. the process sets are disjoint) 
  When the job completes, the breakpoints are 

automatically removed 

Breakpoints 
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Creating A Breakpoint 
  Select the process set that 

the breakpoint should apply 
to, in this case, the workers 
set 

  Double-click on the left edge 
of an editor window, at the 
line on which you want to set 
the breakpoint, or right click 
and use the Parallel 
BreakpointToggle 
Breakpoint context menu 

  The breakpoint is displayed 
on the marker bar 
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Hitting the Breakpoint 
  Switch back to the Root set 

by clicking on the Change 
Set button 

  Click on the Resume button 
in the Parallel Debug view 

  In this example, the three 
worker processes have hit the 
breakpoint, as indicated by 
the yellow process icons and 
the current line marker 

  Process 0 is still running as its 
icon is green 

  Processes 1-3 are suspended 
on the breakpoint 
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More On Stepping 
  The Step buttons are only 

enabled when all processes 
in the active set are 
suspended (yellow icon) 

  In this case, process 0 is still 
running 

  Switch to the set of 
suspended processes (the 
workers set) 

  You will now see the Step 
buttons become enabled 
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Breakpoint Information 

 Hover over breakpoint icon 
 Will show the sets this breakpoint applies to 

 Select Breakpoints view 
 Will show all breakpoints in all projects 
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 Use the menu in the breakpoints view to group 
breakpoints by type 

 Breakpoints sorted by breakpoint set (process 
set) 

Breakpoints View 

Parallel Debugging Debug-27 



  Apply to all processes and all jobs 
  Used for gaining control at debugger startup 
  To create a global breakpoint 

  First make sure that no jobs are selected (click in white 
part of jobs view if necessary) 

 Double-click on the left edge of an editor window 
 Note that if a job is selected, the breakpoint will apply to 

the current set 

Global Breakpoints 
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Terminating A Debug Session 

  Click on the Terminate 
icon in the Parallel 
Debug view to 
terminate all processes 
in the active set 

  Make sure the Root set 
is active if you want to 
terminate all processes 

  You can also use the 
terminate icon in the 
Debug view to 
terminate the currently 
selected process 
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Performance Tuning  
and Analysis Tools 

 Objective 
 Become familiar with tools integrated with PTP, to help 

enhance performance of parallel applications 

 Contents 

 Overview of ETFw and Performance Tools 
 Maybe one slide on each? 
 More detail in separate modules 

Performance and Analysis 
Tools 
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PTP/External Tools Framework 
formerly “Performance Tools Framework” 

Goal: 
 Reduce the “eclipse plumbing”  

necessary to integrate tools 
 Provide integration for 

instrumentation, measurement, and 
analysis for a variety of performance 
tools 

  Dynamic Tool Definitions:  
Workflows & UI 

  Tools and tool workflows are specified in an XML file 
  Tools are selected and configured in the launch 

configuration window 
  Output is generated, managed and analyzed as 

specified in the workflow 
  One-click ‘launch’ functionality 
  Support for development tools such as TAU, PPW and 

others. 
  Adding new tools is much easier than developing a full 

Eclipse plug-in 
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Performance Tuning  
and Analysis Tools - TAU 

 Objective 
 Become familiar with tools integrated with PTP, to help 

enhance performance of parallel applications 

 Contents 

 Performance Tuning and external tools:  
 PTP External Tools Framework (ETFw), TAU 

Hands-on exercise using TAU with PTP 

TAU TAU-0 



TAU: Tuning and Analysis Utilities 

  TAU is a performance evaluation tool 
  It supports parallel profiling and tracing  
  Profiling shows you how much (total) time was spent in each 

routine  
  Tracing shows you when the events take place in each process 

along a timeline 
  TAU uses a package called PDT for automatic instrumentation of the 

source code 
  Profiling and tracing can measure time as well as hardware 

performance counters from your CPU (or GPU!) 
  TAU can automatically instrument your source code (routines, 

loops, I/O, memory, phases, etc.) 
  TAU runs on all HPC platforms and it is free (BSD style license) 
  TAU has instrumentation, measurement and analysis tools 

  paraprof is TAU’s 3D profile browser 
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TAU Performance System Architecture 
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PTP TAU plug-ins  
http://www.cs.uoregon.edu/research/tau 

  TAU (Tuning and Analysis Utilities) 
  First implementation of External Tools Framework (ETFw) 
  Eclipse plug-ins wrap TAU functions, make them available 

from Eclipse 
  Full GUI support for the TAU command line interface 
  Performance analysis integrated with development 

environment 
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TAU Integration with PTP 

 TAU: Tuning and 
Analysis Utilities 
 Performance data 

collection and analysis 
for HPC codes 

 Numerous features 
 Command line interface 

 The TAU Workflow: 
 Instrumentation 
 Execution 
 Analysis 
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TAU PTP Installation 

  This tutorial assumes that the TAU extensions for PTP 
are installed – they are not included in the  
“Eclipse IDE for Parallel Application Developers” 

  The installation section (Module 1) shows how to install 
TAU and other features from the PTP update site –  
be sure TAU was selected 

Module 5 5-5 

To confirm: 
 Help>Install New Software… 
 Select the link “What is already 
installed” at the bottom of the 
dialog 
 You should see the TAU 
Extension 



TAU/ETFw Hands-On(0) 
Assumptions 

 Obtain and install TAU* 
 Download at tau.uoregon.edu 
  The website includes setup and user guides 

 Set up the $PATH on the remote machine* 
  For TAU you should be able to run ‘which pprof’ on a remote login 

and see a result from your TAU bin directory 
 On forge.ncsa.illinois.edu this is accomplished by placing  

‘module load tau’ in the .modules file in the home directory 

 Include ‘eclipse.inc’ in the makefile* 
  Create an empty eclipse.inc file in the same directory as the 

makefile 
  Place ‘include eclipse.inc’ in the makefile after regular compiler 

definitions 
  ETFw will modify eclipse.inc to set CC/CXX/FC variables 

Module 5 5-6 * SC tutorial: this has been done for you 



TAU/ETFw Hands-On(1) 
Begin Profile Configuration 

 The ETFw uses the same run configurations and 
resource managers as debugging/launching 

 Click on the ‘Run’ menu or the right side of the 
Profile button 

 From the dropdown menu select ‘Profile 
configurations…’ 
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TAU/ETFw Hands-On(2) 
Select Configuration 

  Select the shallow configuration 
prepared earlier 

  The Resource and Application 
configuration tabs require little or 
no modification 
  We are using the same resource 

manager 
(edu.illinois.ncsa.forge.pbs.batch.openmpi) 
and PBS settings 

  Since we are using a makefile project 
the application will be rebuilt in and 
run from the previously selected 
location 
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Performance Analysis and TAU 
tabs are present in the Profile 
Configurations dialog 



TAU/ETFw Hands-On (3) 
Select Tool/Workflow 

 Select the Performance Analysis tab and 
choose the TAU tool set in the ‘Select Tool’ 
dropdown box 
 Other tools may be available, either installed as 

plug-ins or loaded from workflow definition XML files 
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Tabs may be 
hidden if the 
window is too 
small 



TAU/ETFw Hands-On (4) 
Select TAU Configuration 

 Select the TAU tab 
 Choose the TAU stub  

makefile: 
 All TAU configurations in  

remote installation are  
available 

 Check MPI, PAPI and PDT  
checkboxes to filter listed  
makefiles 

 Make your selection in the  
Select Makefile: dropdown  
box 

 Select Makefile.tau-openmpi-papi-mpi-pdt 
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TAU/ETFw Hands-On (5) 
Choose PAPI Hardware Counters 

 When a PAPI-enabled TAU 
configuration is selected the PAPI 
Counter tool becomes available 
 Select the ‘Select PAPI Counters’ 

button to open the tool 
 Open the PRESET subtree 
 Select PAPI_L1_DCM (Data cache 

misses) 
 Scroll down to select PAPI_FP_INS 

(Floating point instructions) 
 Invalid selections are automatically 

excluded 
 Select OK 
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TAU/ETFw Hands-On (6) 
Compiler and Runtime Options 

  Other tab settings are described here, 
but no changes are required… 

 TAU Compiler Options 
 Set arguments to TAU 

compiler scripts 
 Control instrumentation 

and compilation behavior 

 TAU Runtime options 
 Set environment variables 

used by TAU 
 Control data collection 

behavior 

 All options included 
context sensitive help 
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Hover help 

On Data 
Collection tab: 
Check Keep 
profiles, and 
Print Profile 
summary 



TAU/ETFw Hands-On (7) 
 If local PerfDMF 

databases are available 
you may select one to 
hold profile output 

 A text summary may be 
printed to the console 

 Profiles may be 
uploaded to the TAU 
Portal for viewing online 
 tau.nic.uoregon.edu 

 Profiles may be copied 
to your workspace 
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TAU/ETFW Hands-On (8) 
  Once your TAU launch is  
configured select ‘Profile’ 
  Notice that the project rebuilds with TAU compiler commands 
  The project will execute normally but TAU profiles will be generated 
  TAU profiles will be processed as specified in the launch 

configuration. 
  If you have a local PerfDMF database  the run will show up in the 

Performance Data Management view 
 Double click the new entry to view in ParaProf 
  Right click on a function bar and select Show Source Code for 

source callback to Eclipse 
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TAU/ETFW Hands-On (9) 
 Use ParaProf for profile visualization to identify 

performance hotspots 
 Inefficient sequential computation  
 Communication overhead 
 IO/Memory bottlenecks 
 Load imbalance 
 Suboptimal cache performance 

 Compare multiple trials in PerfExplorer to identify 
performance regressions and scaling issues  

 To use ParaProf, install TAU from tau.uoregon.edu 
or use Java webstart from tau.uoregon.edu/paraprof  
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GEM -Graphical Explorer  
of MPI Programs 

 Objective 
 Become familiar with GEM and how it can be used in the 

development life-cycle to detect common MPI problems, 
such as deadlocks and functionally irrelevant barriers 

 Contents 
 Overview of GEM 
 GEM installation and features 

 Prerequisites 
 Eclipse IDE and PTP core 
 In-situ Partial Order (ISP), the verification engine 

GEM GEM-0 http://www.cs.utah.edu/fv/GEM 



GEM 
Graphical Explorer of MPI Programs 

 Dynamic verification for MPI C/C++ that detects: 
  Deadlocks 
  MPI object leaks (communicators, requests, etc) 
  Functionally irrelevant barriers 
  Local assertion violations 
  MPI Send/Recv Type Mismatches 

 Offers rigorous coverage guarantees 
  Complete nondeterministic  coverage for MPI (MPI_ANY_SOURCE) 

 Determines relevant interleavings, replaying as necessary 

 Examines communication / synchronization 
behaviors 
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GEM - Overview 

(Image courtesy of Steve Parker, U of Utah) 
GEM-2 

  Front-end for In-situ Partial Order (ISP) 
developed at University of Utah 

  Contributes “push-button” C/C++ MPI 
verification and analysis to the 
development cycle 

  Automatically instruments and runs user 
code, displaying post verification results 

  Variety of views & tools to facilitate 
debugging and MPI runtime 
understanding 

GEM 



GEM – Views & Tools 
 Analyzer View 

 Highlights bugs, and facilitates 
 post-verification review / debugging 

GEM GEM-3 

Browser View 
Groups and localizes MPI 

problems. Maps errors to source 
code in Eclipse editor 



GEM – Views & Tools (cont.) 

GEM-4 

 Happens-Before Viewer 
Shows required orderings and communication matches 

(currently an external tool) 

GEM 



GEM PTP Installation 

  GEM is NOT included in the package: 
“Eclipse for Parallel Application Developers” 

  Gem is installed as an individual PTP feature. Refer to 
the individual feature installation section of this tutorial. 
Be sure GEM is selected. 
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To confirm: 

 Help>Install New Software 

 Select PTP download site 

 Check the GEM Extension 



ISP Installation 

GEM-6 GEM 

 ISP itself must be installed prior to using GEM 

 Download ISP at http://www.cs.utah.edu/fv/ISP 

 Untar isp-0.3.0.tar.gz into a tmp directory: 

 Configure and install 

 ./configure –-prefix=<ISP install directory> 

 make 

 make install 

 Libraries and necessary scripts are installed 



GEM Analyzer View 
 Reports program errors, and runtime statistics 

 Debug-style source code stepping of interleavings 
 Point-to-point / Collective Operation matches 
 Internal Issue Order / Program Order views 
 Rank Lock feature – focus on a particular process 

 Also controls: 
 Call Browser 
 Happens Before Viewer launch 
  Re-launching of GEM 
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GEM Browser View 

GEM 

 Tabbed browsing for each type of MPI error/warning 

 Each error/warning mapped to offending line of 
source code in Eclipse editor 

 One click to visit the Eclipse editor, to examine: 
 Calls involved in deadlock  
 Irrelevant barriers 
 MPI Object Leaks sites 
 MPI type mismatches 
  Local Assertion Violations 

GEM-8 



GEM – Help Plugin 
Extensive how-to sections,  graphical aids and 

trouble shooting section 
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GEM/ISP Success Stories 
 Umpire Tests  

  http://www.cs.utah.edu/fv/ISP-Tests 
 Documents bugs missed by tests, caught by ISP 

 MADRE (EuroPVM/MPI 2007) 
  Previously documented deadlock detected 

 N-Body Simulation Code 
  Previously unknown resource leak caught during  
   EuroPVM/MPI 2009 tutorial ! 

 Large Case Studies 
  ParMETIS, MPI-BLAST, IRS (Sequoia Benchmark), and a few 

SPEC-MPI benchmarks could be handled 

 Full Tutorial including LiveDVD ISO available 
  Visit http://www.cs.utah.edu/fv/GEM 

GEM GEM-10 



Gcov and gprof support in linux tools 

  gcov 
  gprof 
  Linux tools 

Linux-1 



Gprof and gcov setup (local or remote) 
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Run code, inspect gprof output 
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Gprof tab 
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Gcov code coverage 
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Run code, inspect gcov display 
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Gcov with a production code, unexecuted region 

Linux-7 



Gmon with shallow project, MPI 

Setup the MPI run configuration with the Environment variable 
GMON_OUT_PREFIX defined with a name for your individual MPI rank 
gmon outputs.  By default gmon.out is used but MPI doesn't do that well and 
you end up with a profile that's missing most of the information, so by using 
GMON_OUT_PREFIX, each MPI rank adds its process id to its gmon output 
filename.  
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Gmon with shallow project, 1 rank 

The gmon output files can be combined in a summary with the 
gprof -s command as shown.  It's interesting to compare the 
summary gmon output to that from one of the ranks (copy a rank's 
gmon_* to gmon.out to easily view it with Eclipse linuxtools ). 
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Gmon with shallow project, summary 
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Gcov with shallow project 

The gcov view is simlar to the gprof view but keep in mind that you're looking at 
code coverage and not necessarily performance or timing information (though 
there is a relationship...code not executed is performing quite well ! ).  Also note 
that multiple executions will accumulate values in the gcov output files until they 
are removed or truncated to zero-length (2nd run to demonstrate this). 
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Gcov with shallow project, cdt integration 

Selecting (double click) a source code line from either the gcov or gprof view 
and you'll see the file and routine highlighted in the cdt c/c++ perspective.  Also 
notice the support for the .f90 file and its routines.   
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Tutorial Wrap-up 

 Objective 
 How to find more information on PTP 
 Learn about other tools related to PTP 
 See PTP upcoming features 

 Contents 
 Links to other tools, including performance tools 
 Planned features for new versions of PTP 
 Additional documentation 
 How to get involved 

WrapUp-0 Tutorial Wrap Up 



Planned PTP Future Work 

 Scalability improvements 
  UI to support 1M processes 
  Very large application support 

 Usability improvements 
  New wizard to improve setup experience 
  Ability to share configuration information 

 Target Systems 
  Support for additional resource managers and target 

systems 
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Useful Eclipse Tools 

  Linux Tools (autotools, valgrind, Oprofile, Gprof) 
  http://eclipse.org/linuxtools (part of Parallel package) 

  Python 
  http://pydev.org 

  Ruby 
  http://www.aptana.com/products/radrails 

  Perl 
  http://www.epic-ide.org 

  VI bindings 
  Vrapper (open source) - http://vrapper.sourceforge.net 
  viPlugin (commercial) - http://www.viplugin.com 
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Online Information 
 Information about PTP 

 PTP online help  
 http://help.eclipse.org 

 Main web site for downloads, documentation, etc. 
 http://eclipse.org/ptp 

 Wiki for designs, planning, meetings, etc. 
 http://wiki.eclipse.org/PTP 

 Information about Photran 
 Main web site for downloads, documentation, etc. 

 http://eclipse.org/photran 
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Mailing Lists 

  User Mailing Lists 
  PTP 

 http://dev.eclipse.org/mailman/listinfo/ptp-user 

  Photran 
  http://dev.eclipse.org/mailman/listinfo/photran 

 Major announcements (new releases, etc.) - low volume 
 http://dev.eclipse.org/mailman/listinfo/ptp-announce 

  Developer Mailing Lists 
 Developer discussions - higher volume  

 http://dev.eclipse.org/mailman/listinfo/ptp-dev 
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Getting Involved 

 See http://eclipse.org/ptp 
 Read the developer documentation on the wiki 

 http://wiki.eclipse.org/PTP 
 Join the mailing lists 
 Attend the monthly developer meetings 

 Conf Call Monthly: Second Tuesday, 1:00 pm ET 
  Details on the PTP wiki 

 Attend the monthly user meetings 
 Teleconf Monthly: 4th Wednesday, 1:00 pm ET 
 Details on the PTP wiki 

PTP will only succeed with your participation! 
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Thanks for attending 
We hope you found it useful!

PTP Tutorial Feedback 

 Please complete feedback form 
 Your feedback is valuable! 
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